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Tested Solution: Network Configuration and Inventory 
Management using Upgrade Manager

Upgrading the operating system images across a set of network nodes is an irregular event.  However, it can be a time-consuming and 
frustrating process, as it involves large file transfers, device reboots, and precise process steps that are not always easy to remember (for the 
very reason that they are only irregularly used). Allied Telesis recognises that you do not want to waste time and energy on this particular 
network management chore, and have provided a tool that turns it into a simple, pleasant process.

This tool, Upgrade Manager, also provides a convenient interface for integrating the Software Upgrade process with the related activities of 
Network Inventory control and Configuration Script management.  Automating these tasks together in a single easy-to-use package significantly  
enhances the efficiency with which you can manage your Allied Telesis network.

Network Discovery – Automated Network Inventory Creation

Upgrade Manager searches the network for Allied Telesis devices, discovers their properties, and creates an easily browsed device inventory.

To initiate this process, choose the menu item Tools->Discover Devices

This overview of Upgrade Manager takes you through the capabilities that the tool provides to you, and illustrates the simple steps to 
use each of the functional components.

The facilities that are presented are:

 Network device discovery ■

 Device inventory management ■

 Upgrading Operating System images ■

 Installing feature licences ■

Updating configuration files ■
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This presents a dialog in which you specify the discovery parameters

Note that the devices to be discovered MUST all be configured with a Telnet login account that has the specified Username/Password, and a SNMP 
community with the specified name.

You set the discovery running by clicking the “Start Scan” button. Upgrade Manager will run through each of the specified address ranges, looking 
for Allied Telesis devices.

�
�

�
192.168.43.0       255.255.255.0               192.168.43.27              192.168.43.94
192.168.1.0       255.255.255.0               192.168.1.10                192.168.1.10

192.168.139.0      255.255.255.0               192.168.139.56            192.168.139.201
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When the discovery is complete, the addresses of the discovered devices can be browsed in the “Device Families” box at the top left of the 
application window.  The devices are collected by model:

The discovery process gleans information about each unit, which can be viewed and edited by double-clicking on the device’s IP address in the list.
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Adding further units to an existing inventory

Once the device inventory has been created, using the Discovery procedure, individual units can be 
subsequently added to the inventory, by using the menu item Device->Add Device.

This invokes a dialog box into which you specify the IP 
address, login details, and SNMP community of the device to 
add:

Having specified that information, you then click the “Retrieve 
Info” button to instruct Upgrade Manager to interrogate the 
device for the other details like Model, Family, Serial Number, 
etc.  once Upgrade Manager has retrieved that information, 
you click the “Add” button, to have the device added to the 
appropriate Device Family in the inventory list.
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Reloading the inventory at start-up

As units are added to the inventory, they are auto-saved to Upgrade Manager’s data directory. The information is stored in that directory in group-
specific files – ie all the data on the devices in a specific device group are stored together in a single file for that group.

The inventory is not automatically loaded from those files back into Upgrade Manager as the application starts up; instead, you can choose which 
device groups you wish to load into the application.

To load a group, or a set of groups, choose the menu item File-> Load Device Groups

From the resulting dialog box, choose which groups you wish to load:
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Upgrading switch Operating System images

A key capability of Upgrade Manager is the ability to automate the upgrading of OS images on multiple switches at once.

As the different device families run different operating system releases, the upgrades need to be performed on a per-device-family basis.

Upgrading an AlliedWare PlusTM release
For example, a set of x600 switches can have their AlliedWare Plus Operating System upgraded together.

If you click the button “Release Upgrade (AlliedWare+)” in the “Operations” group box at the left of the application window, then the main Pane of 
the application window is put into a mode that enables you to perform the Alliedware Plus upgrade.

In the main pane, you need to specify:

 The name of the operating system image file ■

 The IP address of the TFTP server from which it is to be loaded ■

 The list of IP addresses of the devices to be upgraded ■

All other items in the pane can be left at default, or set to your requirements.

Once the required information has been entered, and the options set as you desire, you initiate the upgrade by clicking the Start button.
The Upgrade manager will report on the progress of the upgrades.
 

192.168.1.107
192.168.1.218
192.168.1.243 
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When the upgrades are complete, the “Cancel” button on the ”Operation Progress” dialog changes to a “Close”, and the result of all the upgrades 
is reported in the dialog.

192.168.1.218        Idle
192.168.1.243        Idle

3

192.168.1.218        Successful
192.168.1.243        Successful

3
3
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Upgrading 8000S series switches
Upgrading a set of 8000S series switches is also very straightforward.

First, specify the new OS image file, the TFTP server address and the units to be upgraded.

Click the start button, and the upgrade is initiated.

192.168.1.20
192.168.1.21
192.168.1.22
192.168.1.23



 Allied Telesis www.alliedtelesis.comPage 9

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

When the upgrades are complete, Upgrade Manager reports the results of the upgrades:

192.168.1.20        Loading
192.168.1.21        Loading
192.168.1.22        Loading
192.168.1.23        Loading
192.168.1.24        Loading
192.168.1.25        Loading
192.168.1.26        Loading
192.168.1.27        Loading

192.168.1.16        Loading

9

192.168.1.20        Successful
192.168.1.21        Successful
192.168.1.22        Successful
192.168.1.23        Successful
192.168.1.24        Successful
192.168.1.25        Successful
192.168.1.26        Successful
192.168.1.27        Successful

192.168.1.16        Successful

9
9
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Upgrading an Alliedware release
Because the AlliedWare Operating System has a per-unit password for release upgrades, there are a few extra necessary steps in the AlliedWare 
upgrade process.

First, the Serial Numbers of the units to be upgraded need to be collected. To achieve this, choose the menu item File -> Export Serial Numbers:
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In the resulting dialog box, choose the device family, and group of devices that you wish to upgrade:

Click the Export button, and choose a name for the file in which to store the serial numbers:
 



 Allied Telesis www.alliedtelesis.comPage 12

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

Then, to create a software upgrade licences, the file of serial numbers can be sent to Allied Telesis, and a set of licence enabling commands received 
in return.

The licences can be entered into Upgrade Manager by choosing the menu item File-> Generate Licence List File.
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Each of the licence enabling commands are pasted into the resulting dialog box. 

Click OK, and Upgrade Manager will then enable you to save the licences to an XML file:
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When the saving of the file is complete, Upgrade Manager offers to take you straight to the AlliedWare OS upgrade process:
 



 Allied Telesis www.alliedtelesis.comPage 15

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

From there, the upgrading of the units proceeds similarly to the process for AlliedWare Plus and 8000S series switches.

The file containing the licences must be specified.  That will automatically identify the new OS image file.  You need to specify the TFTP server, and 
the list of units to be upgraded:

Click the start button to initiate the upgrades.



 Allied Telesis www.alliedtelesis.comPage 16

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

Installing feature licenses

The process of installing feature licences is quite similar to the initial steps of performing a software upgrade.

Begin by creating a serial number list:
 

This menu item invokes the “Generate Licence List File” dialog.

For each switch that the licence is to be installed into, paste a line into the dialog of the form

  <device serial number>  enable   feature=<feature name> password=<Password>

where the password is obtained from WebGen, or provided to you by some other means.
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When a line has been added for each device into which you wish to install the licence, click the “OK” button.

42091446 enable feature=“AT-BGP” pass=F23D1C7D8034841C7D8018
20491664 enable feature=“AT-BGP” pass=23FD1C78D3055567GHSFK6
50382775 enable feature=“AT-BGP” pass=HSGTY8D30555HGFDGNHG7
30203888 enable feature=“AT-BGP” pass=2YFHH8D3055567498HFTY9
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Click the Save button, and you are offered the opportunity to name the file into which the list of licences will be saved

Once the list of licences have been saved to a file, the system offers you the opportunity to proceed straight to enabling features.
 

20491664                            AT-BGP                                               23FD1C78D3055567GHSFK6
42091446                            AT-BGP                                               F23D1C7D8034841C7D8018

50382775                            AT-BGP                                               HSGTY8D30555HGFDGNHG7
30203888                            AT-BGP                                               2YFHH8D3055567498HFTY9



 Allied Telesis www.alliedtelesis.comPage 19

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

Click OK, and the licences are verified once more, and then installed into the devices:

42091446:          The device has been verified.
20491664:          The device has been verified.
50382775:          The device has been verified.
30202888:          The device has been verified.
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192.168.1.101       Successful
192.168.1.102       Successful
192.168.1.103       Successful

192.168.1.100                 Successful

4
4
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Updating configuration files

To configure a device with a new configuration file, proceed as follows.

First,  double-click the device in the inventory list in the left-hand pane to bring up the dialog for editing the device properties.

Click the ellipsis beside the Configuration File name to bring up a dialog in which to browse for the new configuration file.



 Allied Telesis www.alliedtelesis.comPage 22

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 



 Allied Telesis www.alliedtelesis.comPage 23

NETWORK MANAGEMENT SOLUTIONS
  | Network Configuration & Inventory Management using Upgrade Manager 

Once the new file has been chosen, click apply to install the file 
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Viewing a device’s audit trail

An important element in network change control, and problem resolution, is the ability to call up a history of the actions that have been performed 
on network elements.

Upgrade manager maintains an audit trail of the actions it has performed on each network node, and provides a convenient mechanism for viewing 
a device’s audit trail.

The see the audit trail for a device, right-click on the device in the left-hand pane.

In the resulting pop-up menu, choose the item “View device audit trail”
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This will present a list of the actions that have been performed on that device:
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About Allied Telesis Inc.
Allied Telesis is a world class leader in delivering IP/Ethernet network 
solutions to the global market place.We create innovative, standards-
based IP networks that seamlessly connect you with voice, video and data 
services.

Enterprise customers can build complete end-to-end networking 
solutions through a single vendor, with core to edge technologies ranging 
from powerful 10 Gigabit Layer 3 switches right through to media 
converters.

Allied Telesis also offer a wide range of access, aggregation and backbone 
solutions for Service Providers. Our products range from industry 
leading media gateways which allow voice, video and data services to be 
delivered to the home and business, right through to high-end chassis-
based platforms providing significant network infrastructure.

Allied Telesis' flexible service and support programs are tailored to meet 
a wide range of needs, and are designed to protect your Allied Telesis 
investment well into the future. 

Visit us online at www.alliedtelesis.com


